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Chapter 24
3D Bar Charts 

Three-dimensional bar charts offer you additional flexibility when d
playing data. You can use them to visualize a matrix not as a surface
but as bars of varying heights. You can show the bars either where
are in the matrix, stacked one on top of another, or laid out side-by

This chapter contains the following sections:

Creating a 3D bar chart
Basic steps for creating bar charts and for creating bar charts for function
two variables.

Resizing 3D bar charts
Procedures for changing the size of bar charts.

Formatting 3D bar charts
Procedures for changing bar charts: setting the viewpoint, size, and ma
cation; adding titles; and formatting lines, colors, and axes.
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Creating a 3D bar chart 

To create a bar chart:

■ Define a matrix of values to display. Mathcad will use the rows and column num
of the matrix as x- and y-axes. The matrix elements will be shown as columns 
extending from the xy plane to the appropriate height.

■ Choose Graph⇒3D Bar Chart from the Insert menu. Mathcad shows a box with
a single placeholder, as shown below:

■ Type the name of the matrix in the placeholder. Just as with an equation, Mat
will not display anything until you click outside the plot region.

What you see is a visual representation of the matrix. Mathcad draws a perspec
view of the matrix as a two-dimensional grid lying flat in three-dimensional space. E
matrix element is represented as a column extending above or below this grid by
amount proportional to the value of the matrix element. In the default perspective
first row of the matrix extends from the back left corner of the grid to the right, wh
the first column extends from the back left corner out toward the viewer. 

The perspective on the bar chart depends on the location of the viewer with resp
the surface. You can specify this view by changing the chart's tilt or rotation, as 
described in “Changing your view of the 3D bar chart” on page 547.

Displaying a function of two variables 

A typical 3D bar chart shows the values of a function of two variables. To see su
chart, you must first create a matrix that holds the values of the function, then cre
bar chart of that matrix. Here are the typical steps in plotting a function of two varia
such as that shown in Figure 24-1:

■ Define a function of two variables.
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■ Decide how many points you want to display in the x and y directions. Set up range
variables i and j to index these points. For example, if you want to display 10 poi
in each direction, enter:

■ Define  and  as evenly as evenly spaced points on the x- and y-axes.

■ Fill the matrix M  with the values of f( ).

■ Choose Graph⇒3D Bar Chart from the Format menu.

■ Type M  in the placeholder. Then click outside the plot region.

Figure 24-1: 3D bar chart of a function of two variables.

Resizing 3D bar charts

To change the size of a bar chart, follow these steps:

■ Click in the bar chart to select it.

■ Move the mouse pointer to one of the three handles along the edge of the bar 
The pointer will change to a double-headed arrow.

i 0 9..:= j 0 9..:=

xi yj

xi yj,
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■ Press and hold down the mouse button. While holding down the button, move
mouse. The bar chart will stretch in the direction of motion.

■ Once the bar chart is the right size, let go of the mouse button. 

■ Click outside the bar chart to deselect it.

Formatting 3D bar charts

Mathcad provides many ways to change the way a bar chart looks. These can b
categorized in four groups:

■ Viewing characteristics: the type of plot being displayed; the perspective or p
of view; how tall the tallest bars are; and the presence or absence of borders
enclosing boxes, axes, and coordinate planes.

■ Color and line formatting: how the bars are colored; how the bars are laid out
spacing between the bars.

■ Axis formatting: whether to show tick marks or grid lines on each axis.

■ Title characteristics: how the bar chart will display titles.

To change any of these characteristics, start with the 3D Plot Format dialog box

■ Click on a bar chart to select it.

■ Choose Graph⇒3D Plot from the Format menu. Alternatively, double-click on 
the chart itself. Mathcad brings up the 3D Plot Format dialog box. The View P
of this dialog box is shown below. The remaining three tabs take you to three
additional pages.

■ If necessary, click the tab for the page you want to work with.

■ Make the appropriate changes in the dialog box.

■ To see the effect of your changes without closing the dialog box, click “Apply”. 

■ When you're finished, close the dialog by clicking “OK.” 
546  Chapter 24  3D Bar Charts
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Changing your view of the 3D bar chart

The View page of the 3D Plot Format dialog box lets you modify the general 
presentation of your bar chart. 

To change from a bar chart to another type of 3D plot, click on the appropriate bu
in the Display As group. You can convert a bar chart into a surface plot or a con
plot. These plot types are fully discussed in the corresponding chapters of this User's 
Guide. You can also display just the points at the top of the bars. To do so, click 
Data Points. You can change how the points look by using the Colors & Lines ta
this dialog box. For more information, see Chapter 25, “3D Scatter Plots.”   

To change the perspective, or point of view, from which you see the bars on your c
adjust the numbers in the Rotation and Tilt text boxes. Use an integer between 0 t
degrees. Figure 24-2 shows the effects of varying the rotation and tilt (as well as
vertical scale) of a bar chart. 

■ Increasing the vertical rotation turns the chart clockwise. When the rotation is
to 0, you look straight down the first column of the matrix. The first row of the
matrix points to the right. When the rotation is set to 90, you look straight down
first row of the matrix. The first column points to the left.

■ Increasing the tilt raises you higher above the chart's surface. When the tilt is s
0, you look edge on at the plane of the matrix. When the tilt is set to 90, you l
straight down on the tops of the bars. Think of how tall buildings look when you
on the ground (tilt equals 0) and when you're flying directly above (tilt equals 
Formatting 3D bar charts 547
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Figure 24-2: Different views of a bar chart.

To control how tall the tallest bars look, adjust the vertical scale by changing the nu
in the Vert. Scale text box. This is an integer between 1 and 100. When the verti
scale is small, the variations among the bars will barely be perceptible. At 100, t
variations are such that the chart fills almost the entire frame. Figure 24-3 shows
effects of varying the scale (as well as the rotation and tilt) of a bar chart. 

To add or remove a border around the bar chart, click on Show Border in the Fra
group. The border is a two-dimensional frame around the bar chart. 

To enclose the surface and the axes within a three-dimensional bounding box, cli
Show Box in the Frames group. 

To show the xy, xz, and yz back planes:

■ Click on “Show” in the Back Planes group.

■ To color the surface of the back planes, click on “Fill Color”.

■ To outline the edges of the back planes in a particular color, click on “Edge Col

Figure 24-3 shows the same bar chart with back planes, with a border, and with 
bounding box.
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Figure 24-3: Using a border or a bounding box on a bar chart.

Changing the color and layout of the bars

You can often make a 3D bar chart communicate more effectively by using diffe
colors. In addition, you can switch among several layouts of the bars to show your
most effectively. Use the Color & Lines page of the 3D Plot Format dialog box.
 

To specify the color of your chart, click the appropriate button in the Color Spect
group: 

■ None: The bar chart doesn't show any colors.

■ Increasing X: The largest values along the x-axis will be in red and the smallest 
values will be in blue. Intermediate values will range from yellow through gree
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■ Increasing Y: The largest values along the y-axis will be in red and the smallest 
values will be in blue. Intermediate values will range from yellow through gree

■ Increasing Z: The largest values along the z-axis will be in red and the smallest 
values will be in blue. Intermediate values will range from yellow through gree

Use the Spacing text box to increase the space between adjacent bars on your plo
text box measures spacing as the percentage of the size of the grid on which the
are placed. The default spacing is 20%; the maximum spacing is 99%. As you inc
the percentage, Mathcad makes the bars progressively skinnier. Figure 24-4 sho
different spacing for plots of the same matrix.

Figure 24-4 shows the same bar chart using each of the Color Spectrum options

Figure 24-4: Color and spacing options for bar plots.

You can also control the placement of the bars relative to one another using the
Layout buttons. The three options are: 

■ Matrix: The bars are arranged exactly as the corresponding numbers in the u
lying matrix.

■ Stacked: All the bars coming from the same column of the matrix are stacked
on top of another. An  matrix would therefore appear as n bar clusters, each 
formed by stacking m bars one on top of another.

■ Side by Side: All the bars coming from the same column of the matrix are cluste
together side-by-side. An  matrix would therefore appear as n bar clusters, 
each of which contains m bars.

m n×

m n×
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Figure 24-5 shows an  matrix being displayed using each of these three la
options. Note that if you want to swap rows and columns, you can simply plot the
transpose of the matrix.

Figure 24-5: Different bar layouts with the same bar chart matrix.

Formatting the axes

The Axes page of the 3D Plot Format dialog box lets you modify the format of the a
of your plot. Each axis is described by its own set of check boxes and text boxes

Mathcad generates grid lines for bar charts by extending tick marks up and dow
two back planes adjacent to a given axis. Thus, x-axis grid lines represent lines of 

m n×
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constant x drawn on the xz plane and the xy plane, the two orthogonal planes whose
intersections form the x-axis. The y-axis grid lines and z-axis grid lines are defined 
similarly.   

To choose between using tick marks or grid lines on a selected axis, use the Grid 
check box for that axis. When Grid Lines is checked, Mathcad will extend the tic
marks on the selected axis into grid lines on each adjacent back plane. For exam
checking this on the z-axis will result in lines of constant z on both the yz and the xz 
back planes. If you are showing grid lines, you should seriously consider showing 
planes as well. See “Changing your view of the 3D bar chart” on page 547. Figur
6 shows an example of a bar chart that uses grid lines rather than tick marks.

Figure 24-6: Using the different options for tick marks.

To add or remove numbers for the tick marks on an axis, use the Numbered chec
for that axis. Figure 24-6 shows the differences between having numbers on the
marks and not having numbers.

For bar charts, you can have Mathcad automatically select the number of grid inte
on the z-axis. The grid intervals on the x and y axes always match the rows and column
of the matrix whose elements constitute the bars being plotted.

■ To have Mathcad select the number of grid intervals on the z-axis, use the Auto 
Grid check box. When Auto Grid is checked, Mathcad will automatically select
number of grid intervals on the specified axis.    

■ To specify the number of grid intervals on an axis yourself, enter an integer from 1 
to 99 in the No. of Grids text box. This text box is only available when Auto G
is unchecked.
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By default, Mathcad autoscales the z-axis according to the range of values in the matr
you are plotting. Sometimes you will want to fix the scaling yourself, for example
you are comparing views of related data or setting up a surface animation seque
To set the z-axis limits manually, click on the Autoscale box in the z-axis column of 
the Axes page to uncheck it. Then enter the maximum and minimum values in the 
Val. and Min. Val. text boxes.

Labeling 3D bar charts 

The Title page of the 3D Plot Format dialog box, shown below, lets you add and mo
the title on your bar chart. 
 

To add or edit a title for your bar chart:

■ Type the title for your plot into the Title text box. 

■ To display the title, click on Show Title to insert a check. To conceal the title with
deleting it, click on Show Title to remove the check.

■ To position the title, click on either the Above or Below button. Mathcad places
title either directly above or below your plot. 

■ To change the title's text or position, edit the information in the Title group as
appropriate.

■ Click “OK” to close the dialog box when you have finished.

■ To delete the title, highlight it in the Title text box and press [Del] .

If you initiate this process by double-clicking on the title itself, you'll see an equiva
dialog box.

Figure 24-7 shows how Mathcad positions a title on a 3D bar chart.
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Figure 24-7: Titles on a bar chart.
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